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Information in this document is subject to change without notice and does 

not represent a commitment on the part of Real Image Media 

Technologies Pvt. Ltd. The software described in this document is 

furnished under a license agreement and may be used or copied only in 

accordance with the terms of the agreement. It is against the law to copy 

the software on any medium except as specifically allowed in the license 

agreement. 

No portion of this document, including the drawings, may be reproduced 

or transmitted in any form or by any means, electronic or mechanical, 

including photocopying and recording, for any purpose, without express 

written permission from Real Image Media Technologies Pvt. Ltd. 

Specifications of the products in this manual are subject to change without 

prior notice. 

Qube is the trademark of Real Image Media Technologies Pvt. Ltd. All 

other products, technologies and trademarks mentioned herein are 

properties of their respective owners. 

© 2005, Real Image Media Technologies Pvt. L td. 
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Introduction 

Thank you for purchasing the Qube Digital Cinema Server. 

Qube Cinema provides the ultimate combination of quality, reliability, 

ease-of-use, security and flexibility. Designed from the ground up to 

operate in mission-critical applications, the architecture of the Qube 

system is extremely powerful and modular. Being almost entirely 

software-based allows the Qube system to leverage developments in the 

computer industry to bring cinemas a cost-effective professional product 

that projectionists everywhere will be instantly familiar with. 

Qube Cinema is an entire suite of products that are required for a 

practical, commercially viable implementation of Digital Cinema. 

The Qube XP Digital Cinema Server  is the core component of the Qube 

system that plays picture and sound and provides theatre-automation 

support. Redundant power supplies and RAID 1,0 hard drives bring a high 

level of reliability to the system while a detachable Qube Remote Panel 

provides familiar operational controls such as Play, Pause and Stop along 

with an LCD Display and Menu Keys. Unlike more complex interfaces 
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such as touch-screens or the mouse and keyboard, the Qube Remote Panel 

is a simple, familiar hardware interface that makes projectionists feel 

instantly comfortable with the system. 

The second generation Qube software is database driven and has a flexible 

core media architecture that can work with multiple copies of picture, 

sound, subtitling and metadata files stored on local and shared central 

storage systems. Qube Cinema is based on the modular Microsoft 

Windows XP Embedded Operating System to maximize reliability and 

security while deriving benefit from Microsoft’ s powerful DirectShow 

architecture. 

There are two variations of the Qube Server, the XP-E for the E-cinema 

and Pre-show markets with a DVI output and analog audio outputs and the 

XP-D for the D-cinema market with a CineLink™ equipped HDSDI 

output and AES3 audio outputs. 

The Qube XP server is standards-based and designed for interoperability. 

The system utilizes DCI specified MXF containers with 128-bit AES 
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encryption for media and xml for compositions and shows. RSA 

encryption is utilized for keys. 

The base system handles high bit-rate MPEG-2 pictures and also supports 

Windows Media 9 and is expandable with additional software codecs. 

Audio is uncompressed 16-bit or 24-bit at 48 KHz and 96 KHz. Support 

for JPEG2000 is in the works as well and upgrades will be available at 

attractive prices. Whether for pre-show or feature playback, Qube Cinema 

has the flexibility to support it all. 

Qube Cinema supports subtitling in the TI CineCanvas™ file format and 

subtitles are internally rendered for display along with the picture using 

high quality fonts. 

Media transport is possible using portable USB-2 or 1394a/b hard drives, 

high-speed data lines and satellite multicast transmissions. 

Qube XP Servers can manage media completely automatically by deleting 

older, unused media when additional space is required to ingest new 

media. This again makes the system entirely automatic in operation for the 
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projectionist and theatre manager and considerably simplifies their lives 

while reducing the possibility of human error. 

QubeShare is a shared storage solution for multiplexes with 4 TB of 

RAID 5 storage and Gigabit Ethernet connectivity. Multiple Qube XP 

Servers can be connected to a single QubeShare and directly play shared 

media. Designed to be housed in a secure central location such as the 

Manager’s office or in an IT server room, QubeShare is managed 

remotely and is a high availability system that requires virtually no 

maintenance. 

QubePlex is the central management system with status monitoring and 

control for every digital screen in the multiplex. QubePlex can be installed 

on any computer in the network and provides all technical personnel in the 

theatre instant feedback on the status of all screens while providing the 

manager or projectionist remote control over each individual screen. 

QubeCentral is a web-based digital cinema back-end operations 

management and reporting system that provides movie-on-demand 

download scheduling and transparently and securely transmits access 
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control keys. The system can also be used to schedule commercials and 

provides password-protected online access to as-run logs and the health 

status of units in the field. 

QCast is a unique media transmission system which uses Digital 

Fountain’s patented wirespeed delivery technology to securely move 

media over satellite and broadband networks much more efficiently than 

conventional IP based technologies such as ftp. QCast can handle both 

multicast and point-to-point transfers and is simply the best solution in the 

market for digital cinema networks. 

QubeMaster  is a software-based solution that imports or digitizes HD 

and higher resolution picture as well as sound and encodes into all 

supported image compression formats including MPEG-2 and Windows 

Media 9. The system can also perform 128-bit AES encryption 

simultaneously. QubeMaster provides a very powerful mastering interface 

which allows Track Files to be added to the database, picture and sound to 

be synced accurately to form Reels, Reels to be chained together to form 

Compositions and Shows to be created using one or more Compositions. 
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Qube Cinema Terms and Concepts 

It is useful to understand some of the concepts of Qube Cinema’s internal 

architecture when working with the system. 

The basic unit of content that can be played by the Qube Digital Cinema 

Server is the Track File. A Track File is either a picture, sound or subtitle 

file in one of the supported compression and container formats. Qube 

Servers support multiple compression formats including MPEG-2 and 

Windows Media 9 and can be expanded to include additional compression 

formats. Track Files must also be in a container format supported by 

Qube. The supported container formats include MXF, ASF and AVI. 

Subtitles are supported in the CineCanvas™ format. A Track File is 

analogous to a roll of picture negative or a sound negative in the film 

environment. 

Picture, Sound and Subtitle Track Files are synced together with Start and 

End Points to form a Reel which can be considered equivalent to a Reel 

of a Film Print. 
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Multiple Reels in a specific order go to form a Composition. A 

Composition also has additional meta-data associated with it and usually 

consists of a complete feature film, an advertisement commercial, a 

documentary or other logical unit of programming. In the film 

environment, a Composition can be considered equivalent to a complete 

Film Print. A Composition is the basic unit that can be made into a 

Package or DCP that can be ingested or loaded into the Qube Server as 

described later in this manual. 

A Show is a Playlist consisting of various Compositions and Reels to be 

played in order along with associated Automation Events. A Show can be 

programmed to Pause automatically at specific points, to wait for a 

specified duration or until manually re-started. A Show is the basic unit 

that can be played by the Qube Server as described later in this manual. 

The Qube Server uses the concept of Roles in order to enforce certain 

restrictions on what different people may do on the system. There are 

three pre-defined Roles on the system. 
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The Projectionist is the most basic role on the system. This is the default 

state of the system when no one has logged in on the Windows Graphical 

User Interface using a Monitor, Keyboard and Mouse. The Projectionist 

may only load and play existing Shows on the system. The Projectionist 

cannot Ingest media nor delete any files manually though automatic ingest 

of media is still possible. 

The Manager is the normal operational role on the system for Ingest of 

Media and the creation of Shows. The Manager can also delete content. In 

order to login as Manager, the Windows Graphical User Interface is 

necessary. The default password for the Manager account will be provided 

in a sealed envelope with the system. This password can be changed using 

normal Windows procedures. 

Administrator is a specialized login that allows setup of the system and 

update of the software. The password for the Administrator is not 

available to users of the system. 
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Powering Up the Qube Digital Cinema Server 

The Qube Digital Cinema Server is best powered up in the sequence 

described below. Following this sequence strictly ensures that the 

audience has the best possible viewing experience and minimizes any 

possibility of connected systems such as the Digital Projector, the Cinema 

Processor and the amplifiers and speakers being damaged. 

This assumes that the system has been installed by a qualified technician 

and that all interconnections have been correctly made as described 

elsewhere in this guide. 

�  Switch on the Digital Projector’s Mains Power Switch. In normal 

operation, you may choose to always leave the Mains Power 

Switch on and use only the Projector’s soft Power On key to 

power up and power down the Projector. 

�  Press the Projector’s soft Power On key to trigger its start up 

sequence. 
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�  Wait until the Projector is warmed-up and fully operational. 

Digital Projectors require a warm-up period to perform self-tests 

and to illuminate their lamps before they are ready to display 

images on-screen. 

�  Make sure the Digital Projector’s Shutter (also called the Dowser) 

is closed. This ensures that no images are viewed on-screen by the 

audience until the Qube Digital Server is powered-up and ready to 

show content. 

�  Switch on the Qube Digital Cinema Server by pressing the power 

button on the front panel of the system. 

�  Observe the Remote Panel till the system boots. Initially, the 

Remote Panel will not be lit. After a few seconds of powering up 

the Qube Digital Cinema Server, the Remote Panel will display the 

following message: 

 

� � � � � � � � � � � � � � � � � � �
� � � � � � � � 	 
 � � � � 
 � � 
 �
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�  When the Qube Digital Cinema Server has successfully initialized, 

the Remote Panel may display the following message if this is the 

first time it has been powered up after installation, after an upgrade 

or a configuration change: 

 

�  If you see this message, press the  key to select the Default 

Projector. 

�  Now you should see the following screen: 

 

�  Open the Digital Projector’s Shutter. You are now ready to load 

and play content. 

� 
 � � � � � � � � � � � � � �
� � � � � � � � � �

� � � � � � � � � � � � � � � � � � �
�
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Using the Qube Remote Panel 

The Qube Remote Panel is the main operational interface to the Qube 

Digital Cinema Server. The Remote Panel connects to the Qube Server 

over a USB connection and provides operators with familiar and easy-to-

use Transport Control and Menu Keys along with an LCD Status and 

Menu display. 

The Qube Remote Panel provides access only to a subset of the functions 

of the Qube Digital Cinema Server. Additional configuration and 

management features of the system can be accessed using a keyboard, 

mouse and monitor connected to the system. However, all functions 

required for the daily operation of the system are accessible through the 

Remote Panel alone and the system is not expected to be connected to a 

monitor, keyboard or mouse for routine use. 

The Qube Remote Panel is connected to the main system using an 

extendable USB cable so that it can be placed next to a Viewing Port in 

the Projection Room giving the operator the ability to view the screen 

while operating the system. 
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While Qube Remote Panels are interchangeable across Qube Servers, 

there is a configuration change that must be made on the Server. This 

procedure requires a monitor, keyboard and mouse to be connected to the 

system and is beyond the scope of this manual. 

� � � � � �  !  � � � � �  � � " �

OK

ESC

Menu Selection 
Keys

Menu Navigation 
Keys

Transport 
Control Keys

LCD Status and 
Menu Display

 The Qube Remote Panel 
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The Qube Remote Panel uses large keys that are easy to operate. These 

keys are laid out in two sections, the Transport Control Keys and the 

Menu Navigation and Selection Keys. 

The backlit, colored Transport Control Keys control the playback of the 

Shows in the system and their functionality will be immediately obvious 

to anyone who has ever used a CD or DVD player or a tape recorder. 

The Menu Navigation and Selection Keys are used to move through the 

different menu selections available in the system for loading Shows and 

configuring options. 

Qube Remote Panel Keys 

Transport Control Keys 

 

The Stop Key is used to stop the item currently being played. The Stop, Pause and 
Play Transport Control Keys are active only when the system is in Transport Mode. 
These keys cannot be used when the system is in Menu Mode. 

 

The Pause Key is used to pause playback or to resume playback of a paused event. It 
is also used to pre-cue an item when in the Stop State so that it is ready for an instant 
start. When in Pause, the system displays a still picture on the screen and mutes audio. 

 

The Play Key starts playback of an event. It can also be used to resume playback of a 
paused event. If an event has not been pre-cued by pressing the Pause Key first, there 
will be a brief delay in starting playback when the Play Key is pressed. 
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Menu Navigation Keys 

 

The Up Arrow Key is used to scroll up on Menu Items displayed on the LCD Screen. 
If there are no further Menu Items above the Current Item, this key will perform no 
action. A � symbol indicates the currently selected Menu Item. 

 

The Down Arrow Key is used to scroll down on Menu Items displayed on the LCD 
Screen. If there are no further Menu Items below the Current Item, this key will 
perform no action. A � symbol indicates the currently selected Menu Item. 

 

The Left Ar row Key is used to scroll left on the Menu Items displayed on the LCD 
Screen. This key is not currently used in normal operation but may have special 
applications as described in other Qube documents. 

 

The Right Ar row Key is used to scroll right on the Menu Items displayed on the LCD 
Screen. This key is not currently used in normal operation but may have special 
applications as described in other Qube documents. 

Menu Selection Keys 

OK

 

The OK Key is active only when the system is in the Stop State. It is used to select a 
Menu Item displayed on the LCD Screen. A � symbol indicates the currently selected 
Menu Item. The OK Key is also used to first enter the Menu Mode. 

ESC

 

The Escape Key is used to cancel a Menu Selection and return to the Previous Menu. 
If there is no Previous Menu, the Escape Key exits the Menu Mode and re-activates the 
Transport Mode. 
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Understanding the Remote Panel Status Display 

When the Qube Server is in Transport Mode, the Display on the Remote 

Panel shows the status of the currently loaded Show and the Composition 

and Reels that comprise this Show. When the system is playing, the 

remaining duration of the Show and the Composition or Reel that is 

currently playing are also shown. 

The four elements that comprise the Status Display are shown below: 

 

While the first line of the Status Display shows the Current Show that is 

loaded along with the Remaining Duration of the Show, the second line of 

� � " � � # $ � � � � # %� &&�
� � � � ' � � � � � � � � ( � # ) �

Current Composition 
or Reel 
 

Duration of 
Current Composition 
or Reel 

Current Show 
 

Duration of 
Current Show 
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the Status Display shows the Current Composition or Reel along with its 

Remaining Duration. 

When the system is in the Stop State in Transport Mode, the  and  

keys scroll through the sequence of Compositions or Reels that comprise 

the Show. The second line of the Status Display changes to show each 

Composition or Reel in sequence along with its Total Duration while the 

time display on the first line changes to show the Remaining Duration 

from this Composition or Reel to the End of the Show. 

Press  to Cue the Current Composition or Reel and press  to Play 

it. 

Press the  key to toggle between showing the count-down of the 

Remaining Time and showing the count-up of the Elapsed Time. This key 

can be used to toggle between the two modes when the system is playing. 
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Accessing Menus on the Qube Remote Panel 

The Qube Remote Panel can either be in Transport Mode or in Menu 

Mode. In Transport Mode, the Transport Control Keys are active while in 

Menu Mode, the Menu Navigation and Selection Keys are active. 

�  To enter the Menu Mode, the system must first be in the Stop 

State. If the system is Playing content or Paused, press the Stop 

Key to enter the Stop State. Do not try to enter the Menu Mode 

during a Show! 

�  When the system is in the Stop State, press the  key to bring up 

the Main Menu. The options available in the Main Menu are: 

� � ' * � + , �

� � ' � � � - �

� � � � .  � � , �

� � � � � � �

�  You can use the  and  Menu Navigation Keys to move to 

the desired Menu Item. A � symbol indicates the currently selected 

Menu Item. 
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�  Press the  key to select a Menu Item. 

�  A Menu Item can either lead to a sub-menu which will show a 

further list of menus or to a final list of options to be selected. 

�  To exit a menu and go back to the previous menu, press the  

key. 

�  Pressing the  key when in the Main Menu exits Menu Mode 

and returns the system to Transport Mode. 
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Loading Content 

The Qube Server needs to load media into its internal storage before it can 

play any content. The process of loading the media into the system is 

called Ingesting. This process can either be performed manually or 

completely automated under the control of an external control system such 

as QubeCentral. 

If the content is encrypted, the system will also need a Key to decode the 

content. The Key is packaged in a Key Delivery Message or KDM. The 

KDM is a small file and can be ingested along with the media or 

separately. It is important to understand that every system requires a 

unique Key and that Keys cannot be shared among systems. Usually, Keys 

are also different for different content. The Key controls the validity of the 

content and allows it to be decoded between specific Start Dates and End 

Dates. This validity can be modified or extended by a new Key. 

The content for Qube is usually encoded at a high bit-rate in the MPEG-2 

format or Windows Media 9 formats. The size of an entire 90 minute 

feature film could be as high as 50 Gigabytes or as small as 10 Gigabytes. 
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The Qube Server can ingest Media and Keys in multiple ways: 

�  from a set of CD-ROM or DVD-ROM discs 

�  from USB-2 or IEEE-1394 (FireWire™) hard drives and USB 

Memory Sticks 

�  from a Network Location 

�  from a Multicast Data Transmission 

Ingesting content into the Qube system can take a variable amount of time 

depending on the size of the content and the source of the content. The 

fastest ingest will be from USB or FireWire hard drives. 

In order for content to be ingested, it should have been prepared by 

QubeMaster or a compatible Digital Cinema Mastering System and made 

into a Package that is placed on a hard drive or network location. 

Manual Ingesting requires the Manager to be logged into the system using 

the Windows Graphical User Interface. Manual Ingesting is not possible 

when the system is in its default login of Projectionist. In order to login to 

the system, a computer monitor, keyboard and mouse are required on the 

Qube system. Alternatively, the Windows Remote Desktop feature can be 
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used to connect to the Qube system from an external computer and 

remotely control it over a network connection. 

The process of Manually Ingesting Media and Keys into the Qube 

Server from DVD-ROM discs or USB/FireWire hard drives is described 

below. 

�  Ensure that the system is in the Stop State and that no Menus are 

active because the ingest process will not start in the Play State. 

The Stop Key will be illuminated when in the Stop State. 

If in Menu Mode, press the  key as many times as necessary to 

exit all menus. 

�  Connect the hard drive with the Media and/or Key to a free USB 

or FireWire port on the Qube Server. These ports are available on 

the rear panel of the system. If the content is on DVD-ROM discs, 

insert the first disc into the DVD-ROM drive on the front panel of 

the Qube Server. You can eject the DVD-ROM by pressing the 

Eject button on the DVD-ROM drive. 
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�  Launch the Qube Ingestion Controller application by double-

clicking it on the Windows Desktop of the Qube Server. 

�  Click the “ Ingest From…”  button and specify the location of the 

Package to be ingested in the dialog box. Then click the “ Ingest”  

button to start the process. 

�  Details of the items being ingested such as the Composition, Start 

Time, Progress, File Name, Errors, etc. can be seen in the 

application’s status window. 
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�  If sufficient space is not available to ingest the entire Package, the 

application will check to see if additional space can be made free 

to complete the ingest. The application will try to delete the least 

used and the oldest Packages. Where sufficient space cannot be 

made available, an error will be reported.  

�  To suspend the ingest process, press the “Suspend”  button. 

The process of Automatically Ingesting Media and Keys into the Qube 

Server from DVD-ROM discs or USB/FireWire hard drives is described 

below. 

�  Ensure that the system is in the Stop State and that no Menus are 

active. The Stop Key will be illuminated when in the Stop State. 

If in Menu Mode, press the  key as many times as necessary to 

exit all Menus. 
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�  Connect the hard drive with the Media and/or Key to a free USB 

or FireWire port on the Qube Server. These ports are available on 

the rear panel of the system. If the content is on DVD-ROM discs, 

insert the first disc into the DVD-ROM drive on the front panel of 

the Qube Server. You can eject the DVD-ROM by pressing the 

Eject button on the DVD-ROM drive. 

�  The Ingest process will start automatically in a few seconds. The 

progress of the Ingest can be viewed as a percentage on the 

Remote Panel LCD display. 

 

�  Wait until the Ingest percentage reaches 100%. This means the 

Ingest from the DVD-ROM disc or hard drive is complete. The 

system will automatically return to the Stop State when Ingesting 

finishes. 

� � ! � , �  � ! / / / � 0 %1 �
� � � � ' � � � �



� � � � � � � � 	   
 � � � 
 � �� � � � � 
 � � 
 �  

  30 

�  If Ingesting from a set of DVD-ROM discs, insert the next disc in 

sequence into the DVD-ROM drive and the Ingest process will 

again start for the media on this disc. 

�  After the Ingest process is complete, disconnect the hard drive 

from the Qube Server or eject the DVD-ROM disc from the drive. 

�  Sometimes, even when the media is delivered on a hard drive, the 

Key is delivered on a CD-ROM disc. Insert the disc containing the 

Key into the DVD-ROM drive on the Qube Server and wait a few 

seconds for the Key to be Ingested. This process will only take a 

few moments so it may appear that nothing has happened. 
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Building a Show 

Usually, various types of Compositions are ingested into the Qube system 

including feature films and pre-show material such as advertising 

commercials and trailers. In order to sequence the different Compositions 

in the desired order for a particular cinema, a Show must be created. Only 

Shows can be played out of the Qube Server. Even where only a single 

Composition must be played, a Show containing just this Composition 

must be created. 

Building a Show requires the Manager to be logged into the system using 

the Windows Graphical User Interface. This is not possible when the 

system is in its default login of Projectionist. In order to login to the 

system, a computer monitor, keyboard and mouse are required on the 

Qube system. Alternatively, the Windows Remote Desktop feature can be 

used to connect to the Qube system from an external computer and 

remotely control it over a network connection. 

The process of building a Show from previously ingested Compositions is 

described here. 
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�  Ensure that the system is in the Stop State and that no Menus are 

active because the ingest process will not start in the Play State. 

The Stop Key will be illuminated when in the Stop State. 

If in Menu Mode, press the  key as many times as necessary to 

exit all menus. 

�  Launch the Qube Management Console application by double-

clicking it on the Windows Desktop of the Qube Server. 

Contents of the 
selected folder 

Folders showing the 
types of objects 
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�  The Qube Management Console consists of two Panes. On the Left 

Pane are folders representing Shows, Compositions, Reels, Track 

Files and Media Folders. When these folders are selected, the 

Right Pane displays their contents as icons or text as desired. Only 

Compositions and Shows are within the scope of this manual. 

�  Compositions are further classified into Features, Commercials, 

Documentaries and Shorts for convenience. 

�  In order to Create a Show, right-click on the Shows folder in the 

Left Pane and select New>Show or choose File>New>Show from 

the application menu. 
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�  This will bring up the Show Editor. 

�  Compositions can be inserted into a Show by clicking the Insert 

PlayCompositionEvent icon on the toolbar or choosing 

Insert>PlayCompositionEvent in the application menu. This adds a 

Composition Event to the Show and a drop-down box within the 

Composition Event allows the selection of the desired 

Composition. The drop-down box lists all valid and available 

Compositions on the system. 

�  Additional Compositions can be added to the Show in this manner 

in the order desired. 
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�  Clicking the WaitForTime icon on the toolbar or choosing 

Insert>WaitForTimeEvent in the application menu adds a Wait 

Event to the Show. A Wait Event allows the Show to pause for the 

specified duration. Checking the “ Infinite”  box pauses the system 

until the Pause or Play Key is pressed. 

�  Once a Show has been sequenced, it can be saved by pressing the 

Save icon on the toolbar or choosing File>Save on the application 

menu. The first time a Show is saved, the system asks for the 

Show Name. 

�  Immediately after a Show is saved, it is available to be picked and 

loaded from the Qube Remote Panel. 
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Selecting and Playing (or Resuming) a Show 

A Show can either be played from the start or it can be resumed from the 

position at which it was last stopped or interrupted before completion. The 

procedure to select a Show and Play it is described here. 

�  To enter the Menu Mode, the system must first be in the Stop 

State. If the system is Playing content or Paused, press the Stop 

Key to enter the Stop State. Do not try to enter the Menu Mode 

during a Show! 

�  When the system is in the Stop State, press the  key to bring up 

the Main Menu. The options available in the Main Menu are: 

� � ' * � + , �

� � ' � � � - �

� � � � .  � � , �

� � � � � � �

�  You can use the  and  Menu Navigation Keys to move to 

the Shows Menu Item. A � symbol indicates the currently selected 

Menu Item. 
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�  Press the  key to select the Shows Menu Item. This will list all 

available Shows on the system that are valid and can be played. 

�  You can again use the  and  Menu Navigation Keys to 

move through the various Shows listed. A � symbol indicates the 

currently selected Show. 

�  Press the  key to select the desired Show. 

�  If this Show had previously been stopped or interrupted before 

completion, the system will offer the following options: 

� � 2 � , � " � �

� � � � � 3 �

�  To Resume a Show from where it was last stopped or interrupted, 

select Resume and press the  key. This will Load the Show and 

automatically enter Transport Mode where the system will already 

be in the Play State. 
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�  To Load a Show and start it from the beginning, select Load and 

press the  key. This will Load the Show and automatically 

enter Transport Mode where the system will be in the Stop State. 

You can now press the  key to Cue the clip and then press the 

 key to start the Show. 
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Viewing System Logs 

The Qube XP Digital Cinema Server logs all activity internally to a secure 

and tamper-proof database. The system allows access to the Play Log and 

Ingest Log over a network connection using just a web browser. In order 

to access these logs in this manner, the system must be setup with an 

Ethernet network connection to an external computer with a web browser. 

The Play Log and Ingest Log are also available as signed xml files so that 

authenticity can be verified by an external application. The level of detail 

in these xml logs can be specified as well. The details of the xml 

implementation and access are however beyond the scope of this manual 

and only the procedure to view the logs using a web browser is described 

here. 

In order to view the logs, the following url’s or web addresses are entered 

into the web browser. In the addresses, the specific Qube Server’s 

machine name or IP address must be substituted for <ServerName>. 

�  For the Play Log, http://<ServerName>/logs/ViewLog.htm 

�  For the Ingest Log, http://<ServerName>/logs/IngestLog.htm 
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Checking System Information 

The following procedure explains how you can check system information 

such as the version of the software currently loaded in the Qube Digital 

Cinema Server, the amount of installed and free storage on the system or 

the date and time of the secure system clock. 

�  To enter the Menu Mode, the system must first be in the Stop 

State. If the system is Playing content or Paused, press the Stop 

Key to enter the Stop State. Do not try to enter the Menu Mode 

during a Show! 

�  When the system is in the Stop State, press the  key to bring up 

the Main Menu. The options available in the Main Menu are: 

� � ' * � + , �

� � ' � � � - �

� � � � .  � � , �

� � � � � � �

�  You can use the  and  Menu Navigation Keys to move to 

the Info Menu Item. A � symbol indicates the currently selected 

Menu Item. 
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�  Press the  key to select the Info Menu Item. This will list the 

available Menu options: 

� � 4 � � ,  � � �

� � ' � � � � ! � �

� � � � � � 5 	  " � �

�  The Version option shows the installed Qube Software Version 

and Date of Release. 

�  The Storage option shows the Total Storage available on the 

system as well as the Free Storage. 

�  The Date/Time option shows the current system Date and Time. 

The Date and Time are derived from a tamper-proof secure clock. 
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Setup Options for the Default Projector Device 

The Setup Menu allows some options to be set on the Qube Server. The 

available setup options vary depending on the selected Device. This 

section looks at the various options available for setup of the Default 

Projector Device which is for DVI output systems. 

�  To enter the Menu Mode, the system must first be in the Stop 

State. If the system is Playing content or Paused, press the Stop 

Key to enter the Stop State. Do not try to enter the Menu Mode 

during a Show! 

�  When the system is in the Stop State, press the  key to bring up 

the Main Menu. The options available in the Main Menu are: 

� � ' * � + , �

� � ' � � � - �

� � � � .  � � , �

� � � � � � �

�  You can use the  and  Menu Navigation Keys to move to 

the Setup Menu Item. A >symbol indicates the currently selected 

Menu Item. 
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�  Press the  key to select the Setup Menu Item. This will list the 

available Menu options for the selected Device, the Default 

Projector in this case: 

� � � � � � � � � � � �

� � � � �  � � � , �

�  The options available on the Projector  Menu are: 

� � 6 � � - � � �

� � � � � , �

� � 
 � �  . � 
 , - � � � �

�  The Output option allows the selection of the appropriate DVI 

Output Port that is attached to the Digital Projector in systems 

fitted with more than one DVI Output. This option has a default 

value of “1” . If you enter this Menu Item, it will list all available 

output ports. Even if there are multiple DVI Ports on a system, 

these ports will not be listed as options unless they are connected 

to an active device such as a Digital Projector. 
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�  The Lens option allows the selection of the type of Anamorphic 

Lens attached to the Digital Projector. An Anamorphic Lens is 

used to modify the Aspect Ratio of the Digital Projector to fit the 

required Aspect Ratio of the content on-screen without any 

electronic cropping and squeezing which can reduce the resolution 

and brightness of the image. The Anamorphic Factor of the lens is 

the ratio by which it expands the image on-screen. This option has 

a default value of “Flat”  which means that there is no Anamorphic 

Lens attached to the Digital Projector. The available lens options 

are: 

� � 7 � � � �

� � 
 � � � &/ # 8 �

� � 
 � � � &/ ) # �

� � 
 � � � &/ ) ) �

� � 
 � � � &/ 8 # �

� � 
 � � � &/ 8 0 �

� � 
 � � � &/ 0 0 �
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�  The ActiveAspect option allows the selection of the Active Area 

of the Digital Projector’s imaging device that is used to cover the 

full area of the screen in the theatre. This option is used in practice 

for screens where the image has been cropped and squeezed 

electronically to fill the screen. In order for the Qube Server to 

avoid using the area of the Digital Projector’s imaging device that 

has been cropped or masked, the Active Area of the imaging 

device must be setup. This option defaults to the full Aspect Ratio 

of the imaging device as setup under the Monitors Menu. 

Available options are: 

� � 9 � 8 �

� � 8 � ) �

� �&/ ( ( �

� �&( � : �

� �&/ 0 9 �

� � # / ) : �
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�  The Monitors Menu allows the selection of the output resolution 

of each active DVI Port on the system. Depending on the number 

of Active Devices attached to the DVI Ports on the system, the 

Monitors Menu will have one or more sub-menus. The available 

options depend on the resolutions available on the attached Digital 

Projector and are listed as in the sample format shown here: 

� �&� &: # � ; &� 0 � 5 ) # < # 8 = > �

The format is: 

 Output :  Horizontal x Vertical / Colors , FrameRate Hz 

The Horizontal and Vertical Resolutions selected should ideally 

match the native resolution of the Digital Projector’s imaging 

device which can be found in the Projector’s manual. The Frame 

Rate should match that of the content or be a simple multiple of 

the content’s frame rate. The Colors should always be set at 32 

bits. 
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Installation 

The diagram below shows the Rear Panel of the Qube XP-E Digital 

Cinema Server along with descriptions of the connectors. 

Qube XP-E Rear Panel View 

 

 

 

 

 

1 Redundant Power Supply 1 
2 Redundant Power Supply 2 
3 PS/2 Mouse Port 
4 PS/2 Keyboard Port 
5 USB Ports 1 & 2 
6 USB Ports 3 & 4 

7 VGA Port 
8 Analog Audio Output 
9 IEEE 1394a Port 
10 Gigabit Ethernet LAN 
11 DVI Video Output 

2 3 4 5 6 7 1 8 

10 9 11 
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The connections required to setup the Qube XP-E are given below. 

�  The Qube Remote Panel should be connected to any available 

USB Port on the Qube Server 

�  The dual redundant power supplies should be connected to mains 

power using two IEC Power Cords. The Power Supplies are auto-

ranging. 

�  The DVI Output should be connected to the DVI input in the 

Digital Projector. 

�  The Analog Audio Output should be connected to a Cinema 

Processor. 

�  The Ethernet port can optionally be wired to a computer, the 

Cinema’s local area network or to an Ethernet Router. 
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Product Specifications 

Digital Video Output: DVI with HDCP Encryption 
UI Monitor Output: 15-pin D-sub VGA connector (monitor optional) 
Audio Output: 25-pin D-sub Connector for 8-chan Analog Audio 
Video Compression: MPEG-2 4:2:0 & 4:2:2 

Windows Media 9 4:2:0 
Video Resolution: Variable from SD PAL/NTSC to HD 1080P 
Frame Rates: 23.97, 24, 25, 29.97, 30, 50, 59.94 & 60 fps 
Audio Compression: Linear PCM Audio 

Windows Media Audio 
Audio Sampling: 44.1 KHz, 48 KHz and 96 KHz, 16 and 24-bit 
File Formats: MXF packaging for track files 

xml packaging for compositions and shows 
Subtitling: Multi-lingual subtitling 

in the TI CineCanvas™ format 
I/O Ports: Gigabit Ethernet Port, RJ-45 x 1 

RS-232 Serial Port, 9-pin D-sub x 1 
USB 2.0 Ports x 2 
1394 Ports x 2 
Mouse/Keyboard ports 

GPI: optional, 8 opto-isolated inputs 
and 8 relay outputs 

Storage: 160 GB RAID 1,0 storage 
Security: 128-bit AES Encrypted Content Storage 

Start Date, End Date control by 
RSA Encrypted Keys 
Remote authorization on a per-unit basis 

Projectionist Interface: USB Controller with 
Play, Pause, Stop and Menu Buttons 
with 40 char x 2 line LCD Status Display 

Power Supply: 100-240V AC 50/60Hz, 450W 
dual-redundant power supply standard 
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Operating Temperature: 10 to 40 degrees C 
Operating Humidity: 20% to 90% non-condensing 
Size: Main Unit – 3U Rack Mount  

43.2 cm (W) x 13.2 cm (H) x 59.0 cm (D) 
Remote Panel – Hand-held or Wall-mounted 
16.0 cm (W) x 9.0 cm (H) x 4.5 cm (D) 

Weight: Main Unit – 20.5 Kg 
Remote Panel – 0.7 Kg 

 Packed – 30 Kg 
 
Specifications mentioned herein are subject to change without notice due 
to continuous product development 
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